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1

Overview

This document describes how to use the Performance Graph features to measure processing time and
latency on the 1500-OEM and 3000-OEM boards. The performance monitoring graphs are useful for
identifying problem areas and analyzing system performance.
1.1

Associated Documents

EAN-Startup Guide 1500-OEM: Describes steps for connecting, configuring, and testing the 1500-OEM
video processing board on the 1500-AB accessory board.
EAN-Startup Guide 3000-OEM: Describes steps for connecting, configuring, and testing the 3000-OEM
video processing board on the 3000-IO interface board.
EAN-RTSP: Describes how to use various commercial off-the-shelf media players and VMS (Video
Management System) software to stream video from the RTSP server running on 1500-OEM or 3000OEM systems.
EAN-Decoder: Describes how to configure the 3000-OEM as a video decoder.
Interface Command and Control (IDD): Describes the native communications protocol used by the
SightLine Applications product line. The IDD is also available as a local download on the Software
Download page.
Panel Plus User Guide: Provides descriptions of all the settings in the Panel Plus application. (Located in
the Panel Plus application in the Help menu.)
1.2

SightLine Software Requirements

The Performance Graphs feature requires version 2.22.xx and higher.

 IMPORTANT: The Panel Plus software version should match the firmware version running on the
board.

2
2.1

System Performance
Processing

Processing on the SLA boards is divided into two categories:
•

Analyze: Registration, stabilization, tracking, and detection and other non-display processing.

•

Render: Enhancement, blending, rotation, digital zoom, overlays, encoding, and other display
processing.
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2.2

Latency

Figure 1 shows where the board video processing takes place (blue) in relation to total system latency
(external latency sources in white). Each step in the processing introduces latency.

Figure 1: System Latency

Camera Capture Latency: Camera dependent latency in the camera capture, readout, and send-time to
SLA board.
Capture to Telemetry Latency: Internal measurement from the time a frame is captured in the SLA
board to the time that telemetry (frame to frame motion, track location, etc.) is sent out over network
or serial port. This is important when closing a feedback loop in a gimbal.
Capture to Display Latency: Internal measurement from the time a frame is captured on the SLA
board, to the time that a frame is sent out of the system for display (encoded for network video or sent
to Analog or HDMI). This is important for visual latency.
Decode and Display Latency: The time delay introduced in either the network display (decode and
display video) or in a monitor (analog or HDMI). Latency in decoding network video will depend on
software, settings, and PC.
Glass to Glass Latency: Requires an external measurement to determine the time from when the scene
changes, to the time when it is displayed. This number will depend on the camera, processing steps
enabled, and system display.
2.3

Processing and Streaming Frame Rate Expectations

1500-OEM:
•

SD video can be processed and streamed at 30fps with any processing function configuration.

 The 1500-OEM cannot maintain 30fps with 720p input and output. When using this format,
down-step by 2, and set process and display at 15fps. This looks better to the operator than an
achieved frame rate of 20-23fps.
•

The 1500-OEM can maintain 25fps output with 720p/25fps input with stab (no roll correction),
track and MPEG4 encoding.
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3000-OEM:
•

1080p/60 video can be processed and streamed with encoder + KLV configurations.

•

1080p/30 video can be processed and streamed with any processing function configuration and
maintain full frame rate. Single video stream case.

•

A 1080p/30 + 720p/30 second channel can be processed and streamed with any processing
function configuration while maintaining full frame rate, e.g., in a dual video stream use case.

2.4

Glass-to-Glass Latency Values - General Expectations

Example system configurations for glass-to-glass latency are shown in the tables below.
Table 1: 1500-OEM Glass-to-Glass Latency
Software Release

Camera

Input Format

Output Format

Encoder/ Display

Latency

2.24.7.39064
2.24.7.39064
2.24.7.39064
2.25.4.43906
*2.25.4.43906

Analog
Analog
Analog
Hitachi
Hitachi

NTSC
NTSC
NTSC
720p
720p

Analog NTSC
480p
480p
480p
720p/15fps

tv-small
H.264
RTP H.264
H.264
H.264

130
145
150
170
200

 Note on latency for 720p in/out: The 1500-OEM cannot maintain 30fps with 720p input. See
frame rate notes above.
Table 2: 3000-OEM Glass-to-Glass Latency
Software Release

Camera

Input Format

Output Format

Encoder/ Display

Latency

2.24.7.39064
2.24.7.39064
2.24.7.39064
2.24.7.39064
2.24.7.39064

Analog
Analog
Bench HD-SDI
Bench HD-SDI
Bench HD-SDI

NTSC
NTSC
720p
1080p
1080p

NTSC
480p
720p
1080p
1080p

tv-small
H.264
H.264
H.264
RTP H.264

145
145
145
210
210

Table 3: 3000-OEM Glass-to-Glass Latency with HDMI Monitor
Software Release

Camera

Input Format

Output Format

Display

Latency

2.25.1.42458

Bench HD-SDI

1080p 30

1080p 60

HDMI

190

2.25.6.44688

Bench HD-SDI

1080p 30

1080p 30

HDMI

230

2.25.6.44688

Bench HD-SDI

1080p 25

1080p 25

HDMI

245

2.25.6.44688

Bench HD-SDI

720p 50

720p 50

HDMI

180

2.25.6.44688

Bench HD-SDI

720p 60

720p 60

HDMI

160
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3

Performance Optimization

It is important to run a consistent frame rate. For SLA-hardware, providing gimbal feedback at a regular
rate, not occasionally skipping a frame will improve control loops. Motion in output video with
inconsistent frame rate tends to look erratic e.g., 15 Hz can look better than 23 Hz.
3.1

Optimizing Performance

Use the performance graphs to monitor telemetry rate, display frame rate, processor load and process
tree. If the telemetry and/or display rate is at an in-between rate, i.e., 21 Hz, and the processor has a
high load, improvements to the system performance can be made by changing parameters and setting
frame steps.
3.1.1 Video Compression
1500 OEM: Video compression takes significant DSP processor time. Using lower resolution, frame
step and a faster codec will reduce this impact. MPEG4 uses less processor time than H.264 with low
impact to bitrate and quality. MJPEG uses even less processor time, but at the expense of higher
bitrate.
3000-OEM: Video compression does not significantly impact processor load.
3.1.2 Image Rotation, Zoom, Rotation Stabilization
Enabling image rotation, zoom or rotation stabilization increases the render time. If these features are
not being used, turn them off.
3.1.3 Video Enhancement
Video Enhancement increases render time. Turn it off if it is not being used.
3.1.4 Detection
Detection uses more downsample, smaller search area, and frame step to reduce processor time. This
will impact detection sensitivity.
3.1.5 Multiple Displays
Multiple display impacts processor load and latency. Turn off unused outputs, e.g., network + analog »
network only.
3.2

Frame Step

Frame step is set up in the Acquisition Settings tab. The render and display frame step are set up in the
Compression tab.

© SightLine Applications, Inc.

4

EAN-Performance-and-Latency

3.2.1 Capture Frame Step
From the main menu, got to Configure » Acquisition Settings. Setting Frame Step to a value less than 1
throws away frames as they are captured. Analyze and render will not process the discarded frames.
This is most useful for a smooth display frame rate.

Figure 2: Capture Frame Step

3.2.2 Render and Display Frame Step
Render and display frame step are set in the Compression tab. Setting the frame step to value less than
1 skips frame rendering and display. Analyze still processes all frames, but some frames are not
rendered or displayed. This is most useful when using full rate telemetry for control and still being able
to save processing cycles.

Figure 3: Render and Display Frame Step

3.2.3 Frame Step Optimization (SLA systems for gimbal control)
If the camera is 60Hz, set the capture frame step to 2.

 In some setups, it may be possible to run at 60Hz with the 3000-OEM.
If the system is not able to output full frame rate telemetry, increase the render and display frame step
to 30 Hz telemetry to get a smooth display frame rate.
3.2.4 Frame Step Optimization (SLE systems for display)
Increase the capture frame step as necessary to get a smooth display frame rate.
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4

Using Performance Graphs

4.1

Configuring Panel Plus

1. Connect to the board using the Panel Plus application. See the 1500-OEM Startup Guide or the
EAN-Startup Guide 3000-OEM for connection instructions.
2. From the main menu in Panel Plus, go to View » Performance Graphs. A separate window opens
that displays the performance monitoring areas (see Figure 4).

3. To enable/start system monitoring, check the following boxes at the top of the window:

4.2

•

Enable System Status: Shows the processor loads and frame rates at the bottom left.

•

CPU Timing: Displays process timing for major functions.

•

Detailed CPU Timing: Displays process timing for low level functions.

•

Show High Low: Displays the minimum and maximum in the Load Plot.
Performance Monitoring Areas

The Performance Graphs window (Figure 4) displays four performance monitoring areas:
•

Process: Displays CPU execution time broken down by function and latency type.

•

Time Data: Displays a graph of the process functions, matched by color.

•

Loads: Displays processor load, temperature and frame rate.

•

Load Plot: Displays a graph of the Loads information.

© SightLine Applications, Inc.
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Check all boxes

Displays a graph of the
process functions
matched by color.
Process area:
Displays CPU
execution time,
function and
latency type.

Loads: Displays processor
load, temperature, and
frame rate.

Loads information graph.

Figure 4: Performance Graphs
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4.3

Process Area

All the timings show the average, minimum, and maximum execution time or latency in microseconds.
Labels and can be expanded by clicking on the + sign. The data for each is collected and updated every
few seconds.

 The list order of the process areas (analyze, compress, render, etc.) may vary depending on when
the monitor begins to poll the CPU.

 Click Reset to clear out stale categories as setting are changed.
4.3.1 Example Process Tree (1500-OEM)
DSP: Displays Ave, Min, and Max time to run each processing function each frame.
 Analyze (register, track, etc., average 3.243 ms)
 Compress (encoding h.264, average 17.664 ms)
 Render (enhance, rotate, draw graphics, etc., average 4.860 ms)
ARM: In most cases the ARM processor is not the limiting factor in system performance.
Latency: Internal time between capture frame completion and video or telemetry output.
 CapToTel: Time from capture to sending telemetry to network or serial (average 4.266 ms)
 CapToH264: Time from capture to putting H.264 video on the network (average 27.874 ms)

Figure 5: 1500-OEM Example Process Tree

 When a system is running at full frame rate (typically 30 fps), CapToTel will be close to the analyze
time in the DSP tree and CapTo H264 will be close to the sum of Analyze, Render, and Compress in
the DSP tree. When a system is running below full frame rate, the latencies will be higher due to
frame buffering.

 Additional communications and processing steps add small amounts of latency. These values will
not add up exactly to the latencies shown.

© SightLine Applications, Inc.
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4.3.2 Example Process Tree (3000-OEM)
The 3000 has multiple DSPs and up to two simultaneous video chains. It also has a dedicated hardware
encoder which contributes to latency, but not to DSP processor load for video compression.
DSP: Helper DSP when DSP1/2 are enabled, primary DSP for low power mode.
DSP1: Video processing routines for the first camera.
DSP2: Video processing routines for the second camera.

Figure 6: 3000-OEM Example Process Tree

DSP1: Cam 0 Ave, Min, and Max time in (us) to run each processing function each frame.
 Analyze (register, track, etc., average 7.383 ms)
 Render (enhance, rotate, draw graphics, etc., average 1.582 ms)
DSP2: Cam 2 Ave, Min, and Max time (us) to run each processing function each frame.
 Analyze (register, track, etc., average 9.793 ms)
 Render (enhance, rotate, draw graphics, etc., average 2.011 ms)
Latency: Internal time between capture frame completion and video or telemetry output.
 CapToH264[0]: Network 0 time from capture to putting H.264 video on the network (average
42.816 ms)
 CapToTel[2]: Cam 2 time from capture to sending telemetry on the network (average 18.905 ms)
 CapToTel[0]: Cam 0 time from capture to sending telemetry on the network (average 12.825 ms)

© SightLine Applications, Inc.
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5

Measuring Decoder Latency with Performance Graph

The 3000-OEM can be configured to be used as a decoder as described in EAN-Decoder. The decoder is
supported in software version 2.25.xx and higher.
Follow the steps in EAN-Decoder to configure the 3000-OEM to support the IP camera input using
Panel Plus software. Configure the 3000-OEM to either receive video from a Network Source or from
the MicroSD card.
Once the decoder starts receiving video the Performance Graph can be used to measure the latency
involved in decoding frames. See the Performance Monitoring Areas section for Performance Graph
monitoring. A sample performance graph when the 3000-OEM is configured as a decoder is shown in
Figure 7.
In this example, camera 0 is configured as a decoder that receives a 1280x720 video over the network
from another 3000-OEM.
CapToDecoded time is the time difference between receiving a compressed frame of video and when
the decoder returns with an uncompressed frame.
CapToTel is the time difference between receiving a compressed frame of video and sending telemetry
data to the network or serial port.

 The CapToTel time starts as soon as the uncompressed frame is received. This includes the time to
decode the frame.

Figure 7: Performance Graph for Decoder
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6

Measuring System Latency

This section describes different methods to setup and perform latency tests using an oscilloscope and
online digital clocks. Two examples of digital clocks are available at Flash Clocks and Java Script Clock.
A connection to the video processing board using the Panel Plus application is required. See the 1500OEM Startup Guide or the EAN-Startup Guide 3000-OEM for connection instructions.
6.1

Oscilloscope Latency Test

Follow the steps below to measure end-to-end latency using an oscilloscope and blinking LED
configuration. Correct measurement requires a blinking LED with blinking interval ~1 sec.
1. Connect the LED light green cable to CH1 ground on the oscilloscope. Connect black/brown LED
light cable to the probe.
2. Power on the oscilloscope and LED light.
3. Tape the LED light close to the camera lens.
4. Position the Panel Plus display to center on the LED. Press the Autoset button on the oscilloscope.
The display should show a pulse on CH1 after a few seconds. The pulse should remain in the same
location on the oscilloscope display. If the display is not showing the pulse, use the CH1 menu and
make sure the following parameters are correct:
•
•

Trig on downslope
X10 on probe (check the probe)

Normal trigger mode
DC Coupling for channels (looks better)

•
•

5. Tape the sensor to the monitor. Position the Panel Plus display to center on the taped sensor. Plug
in the 5.7 V power. Connect CH2 ground to one side of the sensor resistor and the CH2 probe to the
other side of the resistor.
6. Locate the CH2 pulse with the oscilloscope. If it is at the top of the oscilloscope display, the pulse is
too large. Select CH2 and use the Position knob and CH2 position to move CH2 into view and show
a good pulse.
7. Go to the Trig menu. Set the following settings:
•

Slop: Falling

•

Trig Mode: Normal

•

Source: CH1

Move the horizontal trigger line anywhere on the CH1 pulse. Move the pulses to the left using the
round knob on the oscilloscope.
8. Measure the difference between the two pulses. Press the Cursor button on the oscilloscope, and
then moving the cursor of CH1 to the start of edge transition (falling edge) of the CH1 pulse. Move
the cursor of CH2 to the start of edge transition (falling edge) of the CH2 pulse. Type should be
Time.
9. Use the Acquire button and select Average. Average is set to 16 by default.
10. Use the cursor button and place the falling edge of the cursor to the midpoint of the start of the
edge transition of CH2. The falling edge should change slowly at first. Wait until the curve is formed
before reading the delta. This gives the average, versus a range (the CH2 pulse edge changes) from
the previous step.
© SightLine Applications, Inc.
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6.2

Online Millisecond Clock Latency Test

1. Use any online digital clock available on the web.
2. Stream network video and decode with Panel Plus.
3. Overlap the millisecond clock on the web page with Panel Plus.
4. Use the Snipping Tool and create a screen capture.
5. Subtract the two numbers to obtain the latency measurement, e.g., 707 - 540 = 167 ms.

 End-to-End Glass latency value depends on several factors other than the SLA firmware and SLA
Decoder. Windows OS version, display monitor latency, network configuration, and refresh rate also
affect latency.

Figure 8: Panel Plus Online Digital Clock Overlap

6.3

RTSP Latency Measurement

See EAN-RTSP for more information on how configure the VLC application to stream video from the
RTSP server running on 1500-OEM or 3000-OEM systems.
1. Use any online digital clock available on the web.
2. Point the camera to the millisecond clock on the web page.
3. Open the VLC application.
4. Go Tools » Preferences » Input / Codecs » Default caching policy. In the drop menu select Lowest
latency.
5. Stream VLC using RTSP. Go to Media » Open Network Stream. In the URL field enter the IP address
of the SLA board: e.g., rtsp:\\192.168.1.145\net0
6. Use VLC to start streaming the clock. The clock screen should appear twice in VLC.
7. Use the Snipping Tool and create a screen capture.
8. Subtract the two numbers to obtain the latency measurement, e.g., 707 - 540 = 167 ms.
© SightLine Applications, Inc.
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7

Questions and Additional Support

For questions and additional support, please contact Technical Support. Additional support
documentation and Engineering Application Notes (EANs) can be found on the Support pages of the
SightLine Applications website.
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